/”\ LAKEDALE

COMMUNICATIONS

Dial-up Internet & E-mail Setup Instructions
for

Windows Millennium (Me)

If, after you have read this entire document, you are still having difficulties with the installation, please
contact Lakedale’s Internet Help Desk at:

320-274-9800 Annandale, Maple Lake, and South Haven
320-243-9800 Paynesville

763-675-9800 Buffalo, Montrose, Rockford, Twin Cities, and Waverly
877-535-3375 Toll-Free

Technical Support 24 /7

HAstart| —> -gg

Settings DiaI-Llp
Metwarking Connection

Make Mew Connection

Tvpe a name for the computer pou are dialing:

| Lakedale

Click on Start on the Taskbar. Go to Settings
and click on Dial-Up Networking. Double-click
on Make New Connection.

Select a modem:

w22 [ (Your Modem’s Name Here) =]

LConfigure... |

The Make New Connection window appears. The
default name is My Connection. Type in a new
name: Lakedale.

Click Next >,

< Bach I Mext » I Cancel |

At the Phone Number Window, type in the
phone number to call the modem pool. See the
chart below.

Make New Connection

Type the phone number for the computer pou want to call:

Afea code: Telephone number:
Click Next>. | =]
Country code:
Lakedale Modem Pool Phone Numbers |Urited States of America (1) |

274-9500 Annandale, South Haven
963-9500 Maple Lake

243-9500 Paynesville

675-9500 Buffalo, Montrose, Twin Cities, &

286-6622

Waverly
Cokato, Dassel, & Howard Lake

< Back I Mext = I Cancel
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Dial-up Internet & E-mail Setup Instructions for Windows Millennium (Me)

Make Mew Connection I

Make sure you choose a phone number that is a
local call for you. If you choose one that is long
distance, you will be billed for the long distance
calls.

r'ou have successfully created a new Dial-Up Metworking
connection called:

| Lakedale

Click Finigh to save it in pour Dial-Up Metworking folder.
D ouble-click it bo connect.

Click Finish to create the connection
icon shown below.

To edit this connection later, click it, click the File menu
and then click Properties.

@] ;
—
g“ﬂ-

Lakedale

¢ Back I Finizh I Cancel |

Put your mouse pointer over the icon above, and click the mouse’s right button once. A menu box will
open. Click once with the mouse’s left button on Properties to open up the properties for this connection.

BT x|

General I Server T_l,lpesl Scriptingl Multilinkl
Make sure that the area code and telephone

number you are calling are correct. Also, By
make sure that your modem is selected in the [=The
Connect using window.

— Phone rumber;

Area code: Telephone number:
| =l

Country code:;
ILlnite-:I States of America (1] j

Next, click on the tab Server Types at the
top of the window. [T Uze area code and Dialing Properties

— Connect using:

G | U s Robotics 56K Win INT =l

LConfigure. . |

k. I Cancel
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Make sure that the Type of Dial-Up Server starts

with PPP.

Under Advanced options, the only box that should

General  MNetworking IScriptingl Multlik |

Type of Dial-Up Server:

Modem K E3 |

be checked is Enable software compression.

IF'F'F': Internet, Windows NT Server, Windows 98 j

—Advanced ophions:

Under Allowed network protocols, the only box &l Erietio seitwere comrresso

that should be checked is TCP/IP.

Click OK when finished.

Now, double click with the left mouse
button on the icon Lakedale in the
Dial-up Networking window. Make
sure the number you are calling is
correct.

Make sure you are not dialing long
distance. If you are in the 320-area
code make sure that 320 is not being
dialed.

In the User name field, type in your
full e-mail address (example:
username(@lakedalelink.net).

In the Password field, type in your
password. If you check Save
password, you won’t have to enter it
each time you try to check your mail.

[~ Require encrypted password
[ Require data enciyption

[" Becord a log file for this connection

— Allovwed network, protocols:
[ MetBELI
[T IP%/5P% Compatible

v TCRAP TCE/IP Settings... |

Q. I Cancel |

£ Connect To

= Lakedale
=

Uzer name: !username@lakedalelink.net

EEISSWI:I[EI: 1xxxxxxxxx

¥ Save pazsword

Fhone number: I 2749500

Dhialirng from; I j

Connect |

Cancel

If the phone number is not correct, click on Dial Properties.
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It the area code is wrong, delete it and then type the
correct area code. If you need to turn off/on 10-
digit dialing, click on Area Code Rules and check
always dial the area code (10-digit dialing). Do
not do this if you have 320-area code.

If you have call waiting and need to disable this
feature, check the box To disable call waiting,
dial: Then in the pull down, click on *70. There
may be additional charges to use Call Waiting. If
you are not sure if you can use *70, call our
Customer Service Center.

If you are dialing long distance and your area code
is correct above, make sure the box Dial as a long

distance call is not checked.

Click OK when finished.

Next, you will make sure that your computer’s Network protocols are set up correctly.

First, click on the Start button on your desktop,
then go to Settings and click once on Control
Panel.

When the Control Panel opens, 'I.:I“ E
click twice on the icon Network. =
Mebwiork,

WARNING: If you are on a network (more than
one computer connected together), do not remove
items from this box. Contact your system
administrator before completing installation.

When the window opens, if it looks exactly like the
one to the right, click cancel and continue on to
page 5.

If it does not, then your Network protocols will
need to be set up.

If you have more items than what is indicated here,
click on each of them individually, then click once
on the Remove button. Keep doing this until they
are all gone.

Dialing Properties
by Locations |

| am dialing from;

IHDI‘ﬂB

j Hew. .

| Eemove |

| arn in this country/region: Area code:
IUnited States of America j |32D

Area Code Rules... |

—when dialing from here

To access at outside line:
For local calls, dial

-

For long distance calls, dial I
[ Tao dizable call waiting, dial:

Dialusing: " Tone dial  Pulse dial

I ]‘

™ For long distance calls, use this caling card:

|Nane [Direct Dial)

7| | Caling Eard...l

MHumber to be disled: 274-3500

[" Dial a2 along distance cal

Cancel | Apply
Metwork E3
Configuration | Identificatinnl Access Control I
The fallowing netwark, components are installed:
Client for Microsoft Mebworks
Dial-Up adapter
TCRAP
Hemove | EIOpEriEs |
Primany Metwork, Logon:
Client for Microzsoft Metwarks j
File and Print Sharing... |
Description
] Cancel

When all the components are removed, click once on the Add button.
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Choose Client and click on Add.

Click on Microsoft under Manufacturers and
click on Client for Microsoft Networks
under Network Clients.

Click OK when you are done.

Your Network window should look like the one to
the right. If it looks almost identical, but there are
two TCP/IPs, click once on the top TCP/IP and
click once on the Remove button.

If your Network window looks the same, click the
OK button at the bottom of the window. You are
done. Your computer will copy files from your hard
drive. It may even ask for your Windows Me
System Software CD. Follow the Instructions in the
pop-up windows. When you are prompted to restart
your computer, do so.

e B3

Select Network Component Type

Click the type of netwark. component you want to install

Add..

Canhicel |

[ Protacol
Service

A client enables pour computer to connect to other
computers.

Select Hetwork Client

Manufacturers:

Click the Metwork Client that you want ta ingtall, then click OK. If you have
an installation disk for this device, click Have Disk.

Metwark, Clients:

k

& Client for Microsoft Nebwarks
ks

Client far Mefw/are Nebworl
Microzoft Family Logon

Have Disk. .. |

QK. I Cancel |
Metwork
Configuration | Identificationl Arocess Eontmll
The following network. components are installed:
Client for Microsoft Metworks
Mal-Up Adapter
TCPAP
Eemowe | Eroperties |
Frirnary Metwork Logar:
ICIient for Microgzoft Metworks j
File and Print Sharing... |
Dezcription
ak, Cancel
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When your computer restarts, double click on the

Internet or Internet Options Icon in the

Control Panel. %r
Internet

This will open a window called Internet  Options

Properties. It most likely will look like

the window to the right. If it looks different, make

sure that Dial-up Connection is selected to use

your phone line or modem. Make sure your Dial-

up Networking Connection is Lakedale.

If you have the window to the right, make sure that
it says Lakedale (Default) under Dial-up settings.
If it does not, click once on Lakedale to highlight it
and then click on the button that says Set Default.

Next, make sure that the radio button Always dial
my default connection is selected.

Click on Settings.

Internet Properties

Generall Securityl Content  Connections | F'roglamsl .-’-‘«dvancedl

)

Use the Internet Cannection YWwizard to
connect your computer to the Internet.

— Dial-up settings

Lakedale (Defaul)

Add...

Bemaove

I

Settings...

™ Mever dial a connection
(" Dial whenever a network connection is nat present

¢ Blwaps dial my default connection:

Current default: Lakedale Sefefalt

IV Perform system secunity check before disling

— Local Area Metwork [LAN] settings

LAN Settings... |

(] 4 | Cancel | Apply

I ]|

In the Lakedale Settings window, type in your
User name (e-mail address) and Password that
you supplied to us on your Dial-up Internet
Application. (Note: the password will appear as
asterisks. It is encrypted for your protection.)

Click OK and close the Control Panels.

— Automatic canfiguration

Automatic configuration may overide manual settingz. To ensure the
uze of manual settings, dizable automatic configuration.

[ | Automatically detect saftings

[™ Use automatic configuration script

Soiess !

— Prowy zerver

Sddress

i
| FEart: I Ldvaticed) |

— Dial-up zettings

Uzer name: I uzernamegdlakedalelink.net Properties i
Pazzword: I Advanced |
Darmain: I
™ Do not allow Internet programs bo use this connection
4 I Cancel
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E-mail Setup Instructions

Outlook Express — To add an E-mail Account:

If you are using Outlook Express for the first time, you may get a connection wizard when you open the
program. Follow the instruction in the wizard. Note: at the beginning of the wizard, it may ask you if you
want to open a new account or use an existing account. You want to use an existing account. Fill in the
questions in each window with the information provided by Lakedale and click Next. When the
installation is complete, click Finish.

L.

A

9]

10.

11.

12.

13.
14.

Open Outlook Express. On the Tools menu, click Accounts.
Click on the mail tab.
In the Internet Accounts dialog box, click on Add button.

Select Mail to open the Internet Connection Wizard, and then follow the instructions to
establish a connection with a mail server.

Display Name: (Your Real Name e.g., John Smith). Click, Next.

Choose I already have an e-mail address I’d like to use. Type in your e-mail address provided
by Lakedale (e.g., example@]lakedalelink.net). Click, Next.

The incoming mail server type is a POP3 server. The incoming mail (POP3) is:
pop3.lakedalelink.net (in small, lowercase letters). The outgoing mail (SMTP) is:
smtp.lakedalelink.net (in small, lowercase letters). Click Next.

Type in your Account Name. It’s your e-mail address (e.g., example@lakedalelink.net). Put
in your password. If you type in your password here and select Remember Password, you
won’t have to enter it each time you try to check your mail. Click Next. Click Finished.

After you click finished, you will return to the Internet Accounts dialogue box. Make sure
your new account is highlighted. On the right side of the box, select the Properties button.

Click on the Servers tab. Put a check mark in the ox to the left of My server requires
authentication. Click Settings.

Select Log on using. In the Account name field, type in the first part of your e-mail address
hyphen lakedalelink (e.g., example-lakedalelink).

In the Password name field, type in your password and put a check mark in the box to the left
of Remember password. Click OK.

Click on the Advanced tab. In the Qutgoing mail (SMTP) field, type in 587. Click OK.

You are now finished. Click Close.

To learn how to use your e-mail program, click on Help on the tool bar at the top of the Outlook Express
window. Click on Contents and Index. In this help window, you may read on how to use all of the
functions of Outlook Express mail.
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E-mail Setup Instructions (continued)

Netscape Messenger E-mail — Using the Mail Setup Program:

If you have just installed Messenger or have yet to set your preferences for sending and receiving mail,
you will be prompted to use the Mail & Newsgroups setup program (Windows and Mac OS (only) when
you first open your Inbox. Note: Lakedale no longer offers Newsgroups.

The setup program asks you to provide settings for required preferences. If you do not know a setting, you
must exit the program and consult Lakedale’s Help Desk. You can always change these settings later by
choosing Preferences from the Edit menu and selecting the Mail & Newsgroup Preferences category.

To use the Mail Setup Program:
1. Be sure to type the following information exactly as it’s given to you. Match uppercase and

lowercase characters. Click Forward or Back to move through the panels. To cancel your
changes click the window’s close box.

. Your username on the mail server. Same as your E-mail Address.
. Your password for the mail server. Same as your Account Password.
. Your reply-to or return address. Your return address is usually your username

combined with your site and domain names (e.g., helpdesk@lakedalelink.net).

o Your real name: Netscape Messenger includes it with your username when you send
a message. (Hint: Put your name here how you would write it on any application,
e.g., John Smith.)

. The incoming mail server is a POP3 server. The incoming mail (POP3) is:
pop3.lakedalelink.net (in small, lowercase letters).

. The outgoing mail (SMTP) is: smtp.lakedalelink.net (in small, lowercase letters).

2. Click OK.

You are finished. To learn how to use your e-mail program, click on Help on the tool bar at the top of the
Netscape window. Click on Help Contents. In this Help window you may read on how to use all of the
functions of Netscape Messenger.

F:\Admin\Internet Setup Instructions\Lakedale\Dial-up\Dial-up & E-mail Setup for Me.doc 12/1/2009 gg
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